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ONLINE RESOURCES

This fourth edition of Qualitative Data Analysis with NVivo is supported by key 

resources compiled by the authors to help you get to grips with using NVivo. Visit 

https://study.sagepub.com/beekhuyzen4e to find links to:

Screencast video tutorials from co-author Jenine Beekhuyzen that show you click-

by-click how to: 

	 Navigate the NVivo interface 

	 Access the main tools in NVivo 

	 Use Folders, Sets and Cases 

	 Code and Uncode your data 

	 Merge, paste and aggregate Codes 

	 Harness AI integration in NVivo. 

The videos are available for both Mac and Windows versions of NVivo 14. 

Sample NVivo Project files that help you get comfortable with the software and 

practice your skills on real data at your own pace, using the Wellbeing project  

discussed in the book.

Connect with a network of experts from the NVivo community who can help you 

tackle your project head on.
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1

NVIVO
WHERE TO BEGIN?

Chapter Objectives

In this chapter you will:

	• 	learn a brief background to NVivo, outlining its integral role in qualitative 
analysis;

	• 	explore how NVivo can support your research in all stages of the process;
	• 	access the sample project in NVivo through the workspace;
	• 	discover the value of using NVivo for research project management.

Introduction
It is now quite common for any research project to make use of software to support 

data analysis. SPSS is commonly used to analyse quantitative data, and NVivo is the 

world leading software for analysing qualitative data. While NVivo is best known for 

supporting the analysis of primary data collected empirically, mostly interviews, focus 

groups, and surveys, it is essentially a project-management tool for qualitative research 

which can be utilized from your first day of research; from the very first journal article 

or secondary data document. Paulus (2023) argues for using NVivo as ‘the central com-

ponent of a robust digital research workflow’ with the potential to use features across 

the entire research process from reviewing the literature to writing up the study’s find-

ings. They point out that being able to organize and navigate all data, research 

documents, and media files in one ‘textual laboratory’ leads to transparency and sys-

tematization of the process that can be confidently shared and evaluated for 

high-quality outcomes.

In this chapter, we explore the tools that exist to make your research life easier, 

which in turn create excitement about your research and the possibilities. Having 
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QUALITATIVE DATA ANALYSIS WITH NVIVO2

used NVivo and its predecessors for more than two decades each, the authors argue 

and agree that NVivo can add so much value to almost any research endeavour. 

However, if you are new to NVivo with no qualitative research experience, then it is 

highly recommended that you read some key methodology texts or introductory 

texts from within your own discipline. Then use the recommended reading lists in 

those texts to further explore the methodological choices available to you. We 

expect you to find that qualitative methods are a rich, diverse, and complex 

sphere of knowledge and practice.

This chapter is structured to provide a brief background on NVivo and its role in 

qualitative research. We walk through NVivo’s potential role in your daily research rou-

tines, and how it can be used for project management to keep all files and ideas related 

to your research in one place. Then we begin a tour to navigate the NVivo workspace. 

You do not need an exceptionally clear idea about where you are going yet. This chapter 

is simply designed to get you started and get you thinking. The chapter ends with reflec-

tive questions designed to reflexively consider the role of NVivo in your research.

At any time, visit the online resources (https://study.sagepub.com/beekhuyzen4e). 

We provide resources and supplementary materials on the companion website for 

Windows and Mac users.

Qualitative Research
Qualitative methods are a powerful choice when you want to understand details of a 

process or experience, need more information to determine the boundaries or character-

istics of the issue being investigated, or assess – for a variety of reasons – that the best 

information available is non-numeric (e.g. text or visual). The questions that could ben-

efit from a qualitative approach emerge from many fields such as criminal justice, 

education, finance, health care, marketing, organizational development, public policy, 

sports, and user experience. For example:

	• Do alternative drug treatment programmes help incarcerated young adults think 

about their opportunities after release?

	• How does a customized, after-school biology programme for girls influence their 

interest in a career in science?

	• How do company reports explain ‘negative news’ (e.g. losses, legal challenges, 

declining share values) to shareholders?

	• What are physician perceptions of barriers to diagnosing and treating diabetes 

among migrants?

	• Why does a specific marketing strategy for fire alarms/smoke detectors work well with 

some cultural and linguistically diverse groups in the community and not others?

	• When organizational leaders incorporate meditation practices into their 

businesses, how do relationships between employees change?
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	• What processes need to be in place for health impacts to be considered when 

infrastructure development is being planned?

	• What factors influence a professional gymnast when moving away from home for 

intensive coaching?

	• How do NVivo users perceive the relevance of a new software tool?

The diversity of fields and multitude of questions are part of the thrill of qualitative 

research, and you will find questions that invite qualitative data and analysis around 

every corner as you continue building your expertise. As NVivo is not discipline or meth-

odology specific, it can support all research that involves qualitative data.

Such diversity brings unique challenges in the many choices to be made about how 

to handle all the data in your study. Choices will vary depending on whether the 

research involves, for example, exploration, description, comparison, pattern analysis, 

theory testing, theory building, evaluation, or transformation. Another important 

choice is the methodology or combination of methodologies used, and these are con-

stantly evolving and sometimes overlapping. They include the extremities of the 

methodological continuum and everything in between, ranging from more quantita-

tive and realist or empiricist approaches to qualitative data as we might find in content 

analysis or template analysis, through to more qualitative, constructivist, or interpre-

tivist approaches as we might find in ethnography, phenomenology, or grounded 

theory. Methodologists routinely urge researchers to assess the fit between purpose and 

method, with the choice to use a qualitative approach being determined by the 

research question and purpose, rather than by prior preference of the researcher 

(Maxwell 2013). The same is true regarding the use of NVivo, where the tools used 

should be informed by the goals of the research rather than just ease of use, visual 

appeal, or familiarity. We advise against letting the software drive your research. We 

recommend that you sit down at NVivo with a purpose that has been decided upon 

before you engage with the software.

Computer-Assisted Qualitative Data Analysis  
with Software
‘Digital tools offer qualitative researchers analytic capabilities beyond anything we 

could have dreamed of 30 years ago’ (Robins and Eisen 2017). NVivo is a software appli-

cation for storing, managing, and analysing qualitative data. Grouped with others as 

qualitative data analysis software (QDAS) or computer-assisted qualitative data analysis 

(CAQDAS), NVivo was originally developed in Melbourne, Australia by Lyn and Tom 

Richards in 1981 at Qualitative Solutions and Research, later becoming QSR International, 

now Lumivero, LLC.

The key goals and features of NVivo have been retained over time; handling data via 

coding, writing, linking, adding demographics, searching for patterns, and reporting or 
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QUALITATIVE DATA ANALYSIS WITH NVIVO4

exporting data. The capabilities of the software have grown and continue to grow with 

new versions of the software and needs of researchers, with asynchronous virtual team-

work, and true integration with reference management software available in this latest 

version for the first time.

Miles and Huberman (1994) were among the first to argue that the flexible, recursive, 

and iterative capabilities of software provided unprecedented opportunities to challenge 

researcher conceptualizations. When the Richards (1994) developed NUD*IST (later 

NVivo) their analysis ‘became far surer, with provision for constant interrogation of 

themes. The processes of building and interrogating themes gave an impression of con-

stant working at theory built up and peeled back in onion skin layers’ (p. 164). While 

there have always been cautions, warnings and limitations to using any software in the 

research process, there are also flaws in manual processes, thus we encourage you to 

approach your research critically and reflectively.

There is no guarantee that using QDAS inevitably leads to more transparent, rigor-

ous, credible, or accurate research; however, used with intent and guidance, it can add 

a much-needed system with associated processes that can help to organize our research 

and our time, and build up a research repository over time. A challenge facing every 

scholar is how to demonstrate transparency and trustworthiness in qualitative data 

analysis. While it is often seen, and feared, as a mysterious process, CAQDAS can sup-

port qualitative researchers in their efforts to present their analysis and findings in a 

transparent way, thus enhancing trustworthiness. O’Kane et al. (2021) contribute to the 

conversation about the utility of CAQDAS to support inductive qualitative research with 

a goal of transparency and trustworthiness.

For decades, some have historically warned of the ‘dark side’ of such software because 

it might prompt researchers to overemphasize volume of data or distance researchers 

from data (Siedel 1991), with others like Agar ‘having nightmares about two studies – a 

lousy computer analysis and a beautiful analysis done by hand – where the community 

of researchers would immediately gather around the [computer] printout and celebrate 

its form rather than its content’ (Agar 1991: 185). This exemplifies that inadequate 

research processes, regardless of if you use software or not, will often lead to sloppy, 

corrupted, quantified, or mechanized research. (For a detailed example of the appro-

priation of these early claims, their modification and subsequent misuse, see Jackson, 

Paulus and Woolf 2018.) On the flip side, well-defined, consistent, and methodologi-

cally based research processes (regardless of the use of software) will often lead to 

thorough, rigorous, robust, and transparent research.

If you feel comfortable and familiar with qualitative research, you will see 

many places where NVivo mimics the handling of qualitative data through 

highlighting, writing notes, and connecting ideas. If you are new to qualitative 

research, you will learn a lot about handling qualitative data as you experiment 

with different software tools. While we will provide you with tips and tricks and 

pragmatic issues to address, much of what you learn will come through patience 

and experimentation.
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NVivo Across the Research Process
The Five-Level QDA® method is a detailed resource that helps researchers articulate 

methodological strategies through tactical use of the software to satisfy the ultimate 

goals of those strategies (Woolf and Silver 2017). This approach is in sync with the 

early developers of QDAS who were crafting tools that satisfied the research practices 

already used via ‘manual’ methods. This traditional perspective appeals to qualitative 

researchers who do not use software, those who do, and a wide array of experts in 

methodology.

Early QDAS were an immediate and direct result of attempts to translate manual 

methods (using paper, pencil, highlighters, and Post-it notes) into digital tools that 

provide similar tactics to mark, tag, and sort. Part of the reason the methods-first 

metaphor continues to thrive is because of this evolution. The decision of which 

software tools to use and how to use them (as many tools are multi-purpose) comes 

after understanding the design, logic, and methodology of the study. However, to 

assume that there is a one-directional and linear relationship between human 

thought and tool production (or use) is outmoded and no longer an accepted view 

within the sociology of technology. Researchers in a wide array of disciplines are 

looking more closely at the ways society and culture influence the construction of 

technologies and how these technologies also influence society and culture. To 

accept this view means accepting that our qualitative work is sometimes influenced 

by NVivo.

As an alternative to this methods-first mantra, we advocate a methods-with mantra 

(Jackson 2017), acknowledging the potential for mutual influence between researcher 

and software, which urges us to let go of the fear that the software is hijacking the pro-

cess. We still need to learn more about the contexts in which software influences us and 

with what results, with the first step being awareness that the computer mediated tech-

nology may influence and be influenced. One way to audit yourself is to consider how 

you would proceed in your research without software. Use it where it adds value to 

supercharge your research.

Making the Most of Software Tools

The average user of any software program typically accesses only a small portion of its 

capabilities; this is no doubt true for users of NVivo also. If you are using NVivo for a 

small descriptive project, you can work without having to learn complex procedures, 

but if you are undertaking complex analytical tasks, you can find the additional tools 

you need. You can choose how little or how much of the software to use. Most people 

use it to about 60% capacity.

Choices about what tools to use and how to use them are entirely up to you. There 

are, nevertheless, some common principles regarding the most effective use for many 

of the tools, regardless of methodological choices. For example, the labels used for 
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QUALITATIVE DATA ANALYSIS WITH NVIVO6

coding categories will vary depending on the project and the methods chosen, but the 

principles employed in structuring those categories into a branching coding system 

are common to many methods where coding takes place. These common principles 

allow us to describe in general how you might use the various tools. It is then your 

task to decide how you might apply them to your project.

NVivo has a set of tools to assist in undertaking an analysis of qualitative data. The 

use of a computer is not intended to supplant time-honoured ways of learning from 

data or to diminish the role of the qualitative researcher in exploring and interpreting 

rich data. NVivo was created by researchers who precisely used these kinds of manual 

methods. The many benefits of this technology include the ability to:

	• mimic manual strategies for handling qualitative data;

	• develop an efficiently searchable warehouse of data that records the choices made 

during analysis and can be examined and re-examined with relative ease;

	• increase the efficiency of the more mundane and administrative tasks in 

organizing data;

	• extend the longevity and reusability of data because it is no longer stuck in a 

shoebox under someone’s bed, with prior insights long forgotten;

	• push the boundaries of what qualitative researchers can do manually by 

providing a few tools that open new opportunities;

	• improve the efficiency and effectiveness of teamwork through consistent 

processes that capture and combine individual work in one comprehensive 

project.

NVivo continues to be developed with extensive, qualitative researcher feedback to  

support researchers in the diverse ways they work with data.

How to Follow Our Instructions

	• For NVivo clicking instructions, the blue font indicates steps to take in the 

software.

	• When click instructions diverge, the grey font is for Windows users and the black 

font is for Mac users.

	• When the screen shots from Windows and Mac are similar, we will use one or the 

other as a visual. When they are different, we will label the figure to indicate 

Windows or Mac.

	• Tools only available in the Windows or Mac version of NVivo are indicated in the 

section heading with parentheses and/or in the body of the text.

	• To help acquaint you with these instructions, we provide two, brief videos in the 

online resources (https://study.sagepub.com/ beekhuyzen4e) that serve as a 

‘Primer for following the click instructions’.
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Installing NVivo
To begin, let’s install NVivo.

INSTRUCTION 1.1

INSTRUCTION 1.2

Download NVivo

	• 	https://lumivero.com/resources/support/getting-started-with-nvivo/download-and-
activate-nvivo/

Installing NVivo14 for the first time is straightforward. If you were using the trial version 

(which is fully functional), you do not need to uninstall and reinstall the software. Or if 

you have an earlier version of NVivo on your computer, simply enter and activate a new 

licence key to extend your existing version. Once NVivo is installed, activate your licence.

If more than one version of NVivo is on the computer, NVivo will default to open 

the latest version of the software; check which version of NVivo you are working with 

via About NVivo. If upgrading from a previous version of NVivo, follow the prompts to 

convert the older project to the new version. NVivo will keep the original file as is and 

create a copy of the file for the latest version and label it accordingly.

Installing and Pinning Ncapture During NVivo Installation

Install NCapture when prompted during the NVivo installation. If it does not install, this 
can be done manually with a quick Google search (Figure 1.1).

	• 	Google NVivo NCapture Chrome > Download.

Figure 1.1  Downloading NCapture for web pages using Google Chrome
(Continued)
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This downloads a Chrome extension for your web browser to allow the collection of 
web data via the extension and import an entire web page into NVivo – embedded web 
links and all. View NCapture in Chrome extensions and pin it to the Chrome web 
browser for easy access via the puzzle icon (Figure 1.2).

Figure 1.2  Pin the NCapture Chrome extension to Google Chrome ribbon

Launching NVivo

Each time NVivo is launched, the user is asked to enter name and initials to help track 

the work you do in the software (hint: use the same details consistently each time you 

login). This is useful to keep track of when you did what, and if multiple people are 

working on the same project, ideally each user will login into NVivo with their initials 

to track their actions. This can be useful for viewing a research assistant or a colleague’s 

work, or for viewing which codes were created in the past week or month, or for use in 

an intercoder reliability check in teamwork with multiple coders.

If your NVivo project has multiple people working on it, change the default NVivo 

setting to be prompted to change the user login each time NVivo is run (Figure 1.3).

Changing User Login on NVivo Launch

	• 	File > Options > General > Tick Prompt for user on launch and/or change your 
name and initials > Apply. 

We also recommend changing the setting to Update projects on network drives to On 
save rather than On close, which may help recover an NVivo project in the unlikely event 
that it crashes.

INSTRUCTION 1.3
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Figure 1.3  Updating your user profile and prompt to display on each login

The current user logged in will appear on the bar at the bottom left of the screen 
when a project is open (see Figure 1.9). To find out what version of NVivo you have 
installed (Figure 1.4):

	• File > Product Info > About NVivo. 

Figure 1.4  About NVivo to identify your version of NVivo

Once NVivo has launched, the startup screen is displayed, with options to create a new 

project, or open an existing one, including many of the sample projects – one of which 

we explore in depth in this book. From this screen you can login to your MyNVivo 

account, connect to cloud projects that you have access to, get help, and connect.

The launch screen (Figure 1.5) serves as the foundation on which most projects are 

built. From here you can begin a new project, open the sample project, open a recent 

project or another project. You can also login to your MyNVivo account, access any 

cloud project, options related to the application, and the information about the version 

of NVivo you are using under About NVivo.
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Figure 1.5  The NVivo launch screen (Windows)

If working on a team or collaborative project, begin by logging into your MyNVivo 

account.

Logging in

To login to your MyNVivo account on a Mac (Figure 1.6):

	• File > Log in.

Figure 1.6  Logging into your MyNVivo account (Mac)

INSTRUCTION 1.4
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You will be prompted to add your login information to access your my NVivo account.

Figure 1.7  Adding your login credentials to the Lumivero login

Once logged in, you can access your NVivo Cloud projects (Figure 1.8).

Figure 1.8  Accessing your logged in accounts
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Introducing the Sample Project
NVivo’s inbuilt sample project is an excellent way to get to know NVivo. It is a fully devel-

oped project with all the features used, and it is a great building block for finding your way 

through using NVivo for research. Many of the questions you will want to ask of your data 

will be asked in the sample project for your reference. We also refer to our own illustrative 

examples of using NVivo where relevant to help bring the conceptual and methodological 

issues to life. Take some time to explore the Environmental Change sample project.

INSTRUCTION 1.5

Accessing the Sample Project

	• 	After launching the software > Sample Project.
	• Take the NVivo tour.

The Environmental Change Down East project explores the attitudes of individuals in 

13 communities in an area of North Carolina known as ‘Down East’. The goal of the 

data collection and analysis was to foster dialogue among stakeholders (residents, land 

developers, legislators, business owners, etc.) regarding community planning, land use, 

and sustainable development. This project accompanies every licence as an embedded 

sample.

In addition to the sample project, we pull from a broad array of other studies from 

our own experiences, research from the literature, and research stories and examples 

from our colleagues. In a few instances, we also provide a vignette to help illustrate a 

point. When available, we provide references, but these examples tend to come from 

our memories of collegial conversations rather than materials that can be perused in 

greater detail in another publication.

Exploring the Sample Project
The sample project has a range of files arranged in folders. There are images and 

tables in Area and Township and its subfolders, interview transcripts in Word docu-

ments and transcribed audio files in Interviews, PDFs in Literature and News Articles, X 

(Twitter) data in Social Media, and a typical Survey dataset in the Survey folder. 

Depending on where you click in the Navigation View on the left, different items will 

appear in the List View. Open an item in the List View and it will open in Detail View 

on the right (Figure 1.9). In Windows, the Detail View window can be moved to the 

bottom of the screen.
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Figure 1.9  NVivo main interface: Ribbon, Navigation View, List View, Detail View 
(Windows)

Familiarize yourself with the Mac interface, which looks very similar, in Figure 1.10.

Figure 1.10  NVivo main interface: Ribbon, Navigation View, List View, Detail View 
(Mac)
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Properties: Project, File, Code, Case, etc.
Every item in NVivo has properties, including the project. The project properties 

(Figure 1.11) have options related to the specific project that you are working on, 

whereas the application options apply to all projects using your version of NVivo. 

File properties allow you to change the name and description of a file, and likewise 

for a case.

This is where you can change the project (or item) title and the description. 

Note the file name and path location of the project file (in case you lose your pro-

ject file; it happens). View the stop words which contains the excluded words in 

the word-frequency query. See Chapter 9 for more information on word-frequency 

queries.

Figure 1.11  Project properties unique to the current project

The list of users who have accessed this project are listed in the properties (Figure 1.12). 

The other most used feature here is the Audio/Video tab which allows you to add extra 

columns to the transcription of your media files (see Chapter 5).

It is possible to add a password to an NVivo project. Doing so will keep the file 

secure to only those who have the password. Try not to forget it though, as it is not 

easy to retrieve.
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Figure 1.12  Users on a project listed in project properties

Password-Protecting a Project

To create a password for your NVivo project file:

	• File > Project Properties > Passwords.

INSTRUCTION 1.6

It is helpful to be familiar with the Navigation View, List View, and Detail View. In the 

Navigation View on the left side of the screen (Figure 1.13) there are standard buttons and 

subfolders (Windows users also have a customizable quick access area).

	• Data can be neatly organized in files (e.g. transcripts, audio, video, surveys, social 

media) and in folders (e.g. Interviews, Literature, Surveys).

	• Codes are organized to help you examine conceptual or thematic ideas in the 

data, in files (e.g. Communication, Time, Trust, Vaccination).

	• Cases bring together all of the open and closed data about a person, group, or 

any unit of analysis such as an interview or survey participant, or an organization 

or community group. Cases combine qualitative and demographic/quantitative 

data related to your cases of interest (e.g. Barbara, Dorothy, Susan) to explore their 

data in relation to the demographic data.
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Figure 1.13  Navigation View in Windows (left) and Mac (right)

	• Notes store ideas such as interview summaries, daily logs of work, or thoughts 

about codes, and can be linked to files or codes; e.g. you can link Barbara’s 

interview to the memo that is a summary of her interview – discussed later in this 

chapter.

	• Sets are like a shortcut to items, grouping project items that are related, e.g. a set 

for all interviews with men.

	• Queries enable high-level and detailed questioning of the data to view it from a 

variety of perspectives, finding patterns not easily accessible if not using software 

like NVivo.

	• Visualizations bring the data to life with real-time graphs, charts, and tables to 

easily see patterns and access the data behind them.

	• Reports are fully customizable to present files, codes, cases, and classifications as 

a summary of the project.
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The data folder in the Navigation View has three subfolders for your qualitative data:

	• Files are the primary qualitative items in your project. They include text 

documents, pictures, audio, video, surveys, or web-based material such as social 

media.

	• File classifications are attributes and values applied to files. They are used to 

classify files for literature, and with details about the file, e.g. location of the 

interview.

	• Externals are proxy documents for items that cannot be imported. Choose 

externals when:

	{ documents are not available electronically (e.g. handwritten diaries or early 

research journals);

	{ files are too large (e.g. a 1000-page report);

	{ digital formats are not currently supported in NVivo (e.g. an entire GPS 

database);

	{ access to the entire file for analytic purposes within NVivo is not needed (e.g. 

an employee handbook or detailed regulations).

Creating an external will create a record (much like a document) that indicates the exis-

tence of the non-importable file, with a hyperlink that provides quick access to the file if 

it is available electronically). In addition, you can code any summaries or notes you add 

to the NVivo external after it is created.

Managing Files in NVivo
It was the realization that computers could assist with managing data, rather than a 

belief that they were useful for analysis, that prompted early work in qualitative 

computing (Kelle 2004). Computer programs for assisting with qualitative data have 

become sophisticated toolboxes providing multiple ways to approach the manage-

ment of data. Your use of NVivo’s data management tools will vary throughout your 

project, with some being appropriate from the start, and others coming into play 

more as the project develops. Available tools for managing data include folders, sets, 

and cases. Any coding you apply is preserved and links you create are updated auto-

matically if you rearrange your files into folders or sets or subsequently code them 

to cases.

Just as you group books on your bookshelf or put nails in a different set of tins than 

screws, if you have files which differ in some way you have the option to store them in 

different folders to reflect these differences. In the Environmental Change project, the 

researchers have created additional folders for separate storage of different types of data 

(e.g. Interviews, Literature, News Articles).

	• You should place each file in only one folder (i.e. folders contain mutually 

exclusive items).
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	• We recommend considering a folder structure that matches your organization of 

your data on your computer to help ease your way into NVivo, as you already 

know this is a meaningful way to group your data. (You can change this later, just 

as you can rearrange files on your computer.)

	• Be mindful that you will have to click your way through folders every time you 

want to select a file, so try not to create too many nested folders. The use of many 

layers could be a sign that you are using folders for things better handled with 

sets or attribute values.

An NVivo project file has the file extension .nvp (Windows) or .nvpx (Mac) in the same 

way that a Word document has the extension .doc or .docx. On creating a new NVivo 

project, e.g. Jenines_research.nvp, the project opens, and any files imported into the 

project are created as a copy in NVivo with the original files untouched. As you save your 

NVivo project, all files, codes, cases, etc. that exist in NVivo are saved collectively. The 

.nvp / .nvpx file is portable in that it can be moved to another computer and opened in 

NVivo. If opening a Windows file on a Mac, it needs to be converted first via the copy 

project option, however a Mac file does not need to be converted to Windows; simply 

open the .nvpx file in NVivo on Windows.

Creating folders can be done at any time to get organized. Folders are particularly 

useful to separate data types so that you can query, e.g. just what they said in the inter-

views versus what they said in the survey data, versus what was said in the literature.

INSTRUCTION 1.7

Creating a Folder

	• 	Navigation View: Data > Files > Right-click on the files folder > New Folder > 
Name it > OK / Done.

Later you can drag files from the List View into the appropriate folder (or import files 

directly into that folder).

Throughout these instructions, keep in mind that items in the Navigation View some-

times require an extra step to see the subfolders (Figure 1.14).

Accessing Subfolders in Different Views

	• 	Navigation View: Data > Files > Interviews.
	• 	List View: Double-click on the Barbara file (Figure 1.15).

INSTRUCTION 1.8
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Figure 1.14  Showing/hiding folders in the Navigation View in Windows (left) and  
Mac (right)

Figure 1.15  Opening Barbara in the Detail View

	• 	Detail View: This file that opens in NVivo looks like the file when you open it in 
Microsoft Word. On import, NVivo has made a copy of the original file inside of 
NVivo, leaving the original file in its original state. Changes to the file in NVivo will 
not impact the original file outside of NVivo.

	• Navigation View: Coding > Codes.

	{ 	Codes are your concept containers and are discussed in detail in Chapter 7.

	• 	List View: Double-click on the code Community change (Figure 1.16).
(Continued)
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Figure 1.16  Opening the Community change code in the Detail View

	• 	Detail View: This code points to passages in various files that have been coded to 
the code (NVivo calls each coded passage a reference).

A project event log tracks every action taken in the project which can be reviewed at any 

time. This can be activated on install or via the settings.

INSTRUCTION 1.9

Opening the Project Event Log

	• 	File: Open Project Event Log (Windows only).

Windows Users

As you open items in the project, they will continue to stack in tabs in the Detail View 

(Figure 1.17). You can leave many items open and access them via their tabs. You can 

also close any item by clicking on the X in any tab, or right-click and Close all tabs.

Figure 1.17  Opening items in the Detail View with individual tabs (Windows)

Mac Users

As you open items in the project, such as documents and codes, they will stack in tabs 

across the top of the open window in the  Detail View  (Figure 1.18). You can leave many 

items open and access them with a single click. You can also close any item by clicking 
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on the X to the right of the item name. Mac users should also be aware that the Menu 

bar at the top of the screen provides additional options (e.g. File … Window, Help). We 

will occasionally send you to the Menu bar to access software features.

Figure 1.18  Opening items in the Detail View with individual tabs (Mac)

Continuing to Explore the Environmental  
Change Project

Continue clicking around in items in the Navigation View to get a sense of the tools and 

their locations, although the rest of the book will take you through these tools with 

specifically focused chapters. In addition, you can watch our video on ‘The main tools 

in NVivo’ in the online resources (https://study.sagepub.com/beekhuyzen4e) for an 

extended tour of these tools and a guide to the chapters where you will find additional 

information about these tools. After opening a few items (some of which will make sense 

and others which might look strange), you will have a general sense of a fully populated 

project. You will continue in the remainder of this chapter by creating your own project 

from scratch (even if you have not yet finalized your research questions or collected the 

data to answer your research questions). When you are ready, exit the sample project.

INSTRUCTION 1.10

Exiting the Sample Project and NVivo

	• Menu bar: File > Close.

This will close the project without closing the software. If you want to quit working in NVivo 
until another time you can close the project and the software simultaneously:

	• Select the X on the upper right / Red button on the upper left.
	• 	Menu bar: File > Exit / NVivo > Quit NVivo.

Creating Your Own Project
Your project begins from the time you start asking questions – from the thought that X, Y, 

or Z might be something interesting to investigate. This is also a good time to start using 

software! Don’t wait until you begin collecting primary data. Start with secondary data.
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	• Early use of software ensures you do not lose precious early thoughts. Indeed, 

sketching ideas and writing even rough notes will help to clarify thinking as you 

plan your project.

	• Starting early will give you a gentle introduction to the software and a chance to 

gradually develop your skills as your project builds up. This is better than 

desperately trying to cope with learning technical skills in a rush as you become 

overwhelmed with data and the deadline for completion is looming.

	• Starting with software early acts as a reminder that data collection and data 

analysis are not separate processes in qualitative approaches to research.

So, let’s start now! We will help you create a new project and record your preliminary 

ideas in a project journal, mind map, and concept map. You will then import a PDF or 

Microsoft Word document, and create annotations, a memo, and a see also link to start 

writing about ideas prompted by the document.

It is very important that you only work with NVivo projects on your local hard drive 

unless you have purchased the NVivo Collaboration Cloud for teams. There are 

instances of projects getting corrupted if you work on standalone projects saved on an 

external drive, server, or USB drive. Don’t panic! You can work from your local drive and 

save backups to an external drive, or a server and we show you how to do this at the 

end of this chapter. However, as you work through the instructions below to create a 

project, we recommend that you save it in your documents folder on your hard drive.

Creating a Project

	• 	Launch NVivo > New Project / Create new project.
	• Provide a name in the Project Title.
	• Click Next > Create project 
	• Add a description for the project (these can be changed later).
	• 	NVivo assigns a matching file name (or path) for the project file.
	• 	Check the box to Write user actions to project event log.
	• 	By default, the project is saved in your documents folder.
	• 	Profiles and passwords: If you want to customize user profiles or establish 

password protection, see Chapter 3 on Teamwork.
	• 	Save your project regularly, but if you have not taken an action in the project since 

your last save, the option to ‘Save’ will be greyed out. The save button is not 
greyed out on Mac.

	• Menu bar: File > Save.

INSTRUCTION 1.11

Windows users will discover that every 15 minutes NVivo will ask if you want to save 

your changes in case of power failure or crash. There are no save reminders for Mac users. 

For Windows users, there is also the option of enabling autosave. By doing so, the undo 
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button no longer works as actions are saved continuously. When you are working on 

your own project, it is strongly recommended that you save each time you are asked, 

unless you are simply experimenting, do not want to save your changes, or you are in 

the middle of an undo operation.

Exploring Existing Data

Bandara et al.’s (2015) paper presents a step by step example of how NVivo clearly 
illustrated its value for the end-to-end literature review process. The paper was 
authored by five academics who have for many years used NVivo for systematic litera-
ture reviews, to collectively share their examples, their dos and don’ts, to serve as a 
guide for anyone doing research, especially for beginners. Their paper is a useful ‘how 
to’ guide to using software tools for literature reviews from day 1 – positioning literature 
reviews as an activity in qualitative research that most people do not realize! The way 
we approach interviews for analysis, for instance, is very similar to the way we 
approach our literature reviews – using thematic analysis (Ryan and Bernard 2003). 
The outcome of this piece of research was a research agenda for the future of research 
on gender and information systems (Gorbacheva et al. 2018).

EXAMPLE 1.1

Data for your research exists from the first day of your project – from the first research 

brief to the first journal article, to the first news post, to notes about your project. Try 

starting with one or more of these suggestions.

	• Expository or research literature. In many fields, qualitative researchers are expected 

to gain a firm grasp of the relevant literature, and for university-based research, 

prior understanding of the literature on the topic is an essential element of a 

funding application or doctoral research proposal. The belief that an inductive 

approach to inquiry requires researchers to come to their data without having 

been influenced by prior reading of the literature in their field and without 

bringing any theoretical concepts to the research is generally no longer seen as 

feasible, nor is it broadly supported. Corbin and Strauss (2015: 78) declared: 

‘Insights do not happen haphazardly; rather they happen to prepared minds 

during interplay with the data.’

	• Observations of yourself and of others. Field notes or diary records could play a 

significant early role. Create documents in which you can record your 

observations.

	• Data already in the public sphere. Examples include newspapers, novels, radio, 

websites, social media, images, recordings, or archived data. These can provide 

valuable learning experiences as you master both software and analysis 

strategies.
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In Silverman’s insightful little pink book aptly titled A very short, fairly interesting and 

reasonably cheap book about qualitative research (2013), he differentiates between natu-

rally occurring data and manufactured data. The former is data that exists in the world 

without you, while the latter is data created, or manufactured, during your study. He 

argues that we often first choose to create manufactured data before fully exploring the 

plethora of naturally occurring data that exists, even though this is often a more difficult 

approach. There is merit in exploring what exists first, and then designing data collec-

tion to add value to what already exists.

Saving and Backing Up Your Project

By default, NVivo prompts the user to save the open project every 15 minutes. 

This timing can be changed in the project properties. Saving via the Save button 

or Ctrl-S or Cmd-S will reset the save reminder timer. We recommend that you set 

up a process for backing up your project regularly; this could be at the end of each 

week or even each day. Always have at least two copies of your NVivo project in 

case of any file errors. Remember also that it is not a backup if it is on the same 

machine, so back up to an external source for maximum peace of mind. A naming 

convention for your backup should contain the world backup with the name of 

the project and the date of the backup, e.g. BackupSampleProject20240501.nvp  

or .nvpx.

Save your project periodically as you work. Of course, you should always save as you 

exit the project as well. For safety, create regular backup copies as you work. Our recom-

mendation is to make a backup on your working computer at the end of each day’s 

work, and to copy that to another medium (a disk, memory stick, server, or cloud that 

is independent of that computer) on a regular basis. You might also want to retain cop-

ies from important transition points, for example before and after a major restructure, 

before and after combining the work of team members, or when you’ve developed key 

maps or understandings of the project. These copies will help you write up the meth-

ods section of your final product. They can also help you communicate about how 

your ideas developed and thus help convince a reader about the legitimacy of your 

findings.

Backing Up After You Close Your Project

	• 	Go into Windows Explorer or your file manager / Go to Finder > Copy the project > 
Paste into a backup folder and rename or add a date to the backup.

	• 	Windows users might want to match the title with file (or path) name.

INSTRUCTION 1.12
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Backing Up Your Project While You are Working in NVivo 
(Windows Only)

	• File: Save.
	• File: Copy Project.
	• 	The Copy window identifies the project you are in and that is about to be copied.
	• 	The Copy to window allows you to select a version for your copy.
	• 	The Location window allows you to rename the copy.
	• 	We use an international date format (year-month-day) added to the name, so they 

sort in date order (from oldest to newest).
	• 	Identify a location for the copy – we recommend an external drive. Remember, 

however, you should never open and work on a project on an external drive unless 
you are using NVivo Collaboration Server (previously NVivo for Teams).

	• 	Or, convert a Windows project into a Mac compatible project if you work across 
platforms; however, this should be done with caution due to potential corruption of 
your project (which is why backups are so important!).

Be aware that in the process of copying your project, NVivo will copy your project but then 
return you to the original. In contrast to Save As (in Microsoft Word and many other pro-
grams), you do not end up in the copy at the end of the procedure.

NVivo for Research Project Management
Your research may have several components:

	• data of different types (literature, observations, interview transcripts, a dataset, 

pictures or video, web pages);

	• data generated from different sources (rural and urban; companies A, B, and C);

	• data from different phases of the project (pilot phase and main data collection; 

wave 1, 2, and 3 of interviews).

NVivo provides data management tools that allow you to compare or isolate different 

components within your project. What this means in practice is that it is best to incor-

porate all those components into a single NVivo project, rather than make separate 

projects for each component. Having everything together in one NVivo project will 

allow you to gather all you know on any topic, regardless of the source, and to make 

instant comparisons across different files, phases, types of data, or cases. If you wish, 

you will still be able to interrogate just one component of the data by placing relevant 

files within a specific subfolder, by identifying that component as belonging to a defined 

setset or having a specific attribute value, or by scoping any given query to specific sub-

sets of data. Chapters 2 and 8 will show you how to create and use folders, setsets, cases, 

and attribute values that utilize demographics to manage your data.

Using NVivo during the analysis of qualitative data will help you:
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	• Manage data – to organize and keep track of the many messy records that go into 

making a qualitative project. These might include not just raw data files from 

interviews, questionnaires, focus groups, or field observations, but also published 

research, images, diagrams, audio, video, web pages, other documentary sources, 

rough notes, and ideas jotted into memos, information about data sources, and 

conceptual maps of what is going on in the data.

	• Manage ideas – to organize and provide rapid access to conceptual and theoretical 

knowledge generated during the study, as well as the data that support it, while at 

the same time retaining ready access to the context from which those data have 

come.

	• Query data – to ask simple or complex questions of the data, and have the program 

retrieve from your project all information relevant to determining an answer to 

those questions. Results of queries are saved to allow further interrogation, and so 

querying or searching becomes part of an ongoing enquiry process.

	• Visualize data – to show the content and/or structure of cases, ideas, concepts, 

sampling strategies, timelines, etc. at various stages of the interpretive process, 

and to visually represent the relationships among these items in a range of (often 

interactive) displays.

	• Report from the data – review evidence-based results within and across cases to 

identify patterns and explore them in more detail. Map the research chain of 

evidence and related processes from original sources to analysis to outputs.

Your use and discussion of the software will be influenced by your theoretical frameworks 

and research questions, the colleagues with whom you work, the types of data you han-

dle, the modes you intend to use for communicating your results, and the stakeholders 

who are interested in the implications of your research.

Good advice is to never do anything in your research without writing about it. That’s 

where memos are helpful to journal your ideas, processes, actions, and insights.

Journaling

In an NVivo memo, you can journal any insights gained as you shape your research 

questions and your approaches to analysing the data. These reflections can alert you to 

include certain kinds of people in your sample, to collect information in alternative 

ways, or to explore a broader (or narrower) context. Begin by recording the questions, 

assumptions, or other ideas you are bringing to the project:

	• Why are you doing this research?

	• What do you think it’s about?

	• What are the questions you’re asking, and where did they come from?

	• What do you expect to find and why?

	• What have you observed so far?
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Qualitative researchers typically keep a journal to document how they have moved from 

initial forays in their research to arrival at their conclusions; hence some refer to the 

journal as an audit trail for the study. Lyn Richards (2020: 70) compares the journal-

ing process to keeping a ship’s log with its careful account of a journey, and provides 

detailed suggestions about what might be recorded there:

	• How insights were triggered, and ideas were developed.

	• Fleeting ideas that are captured before additional data and ideas march into your 

consciousness.

	• Lists of things you want to do at another time.

	• The core concepts amidst the sometimes overwhelming options you could (but 

perhaps shouldn’t) pursue in the data to answer your research questions.

	• How you pulled together the evidence to support your conclusions.

Unlike the ship’s log, however, the journal can be a private document and you might 

also record your frustrations and your joys as you work through your research. Perhaps 

the best advice of all, as you focus on ideas and your responses to them (rather than dry 

description), is to enjoy the journaling task. Write freely without worrying about formal-

ity of style or ‘correctness’ of thoughts. Writing ‘often provides sharp, sunlit moments of 

clarity or insight – little conceptual epiphanies’ (Miles et al. 2019: 89).

One clever use of the research journal memo is to add the date on each entry, write in it 

regularly documenting processes and outcomes (and possibly frustrations), and then export 

it out of NVivo at the end of each week and email the file to your team/supervisor/  

colleagues. Always begin each entry at the top of the memo so the latest entry is first.

The journal can also be used in teamwork with each team member having a research 

journal with their name, e.g. Jenine’s research journal. The research journals are regu-

larly updated by team members, becoming a source of ongoing up to date information 

on the project. The date modified column identifies the last update.

In NVivo a journal is a memo with a choice to create a single memo added to regu-

larly, or a series of memos sorted by date. Memos are always editable and can be linked 

to entire files or to specific passages which prompted those thoughts via memo links 

and see also links. Memos can also be coded, making it easy to retrieve the ideas you 

generate on any topic – and this is something you can do with any other memo or 

document you create within your project. No more coloured tags hanging off the sides 

of pages to help you find those insightful ideas.

Perhaps the most important advice is that it does not matter if the typing or the 

grammar is rough, if you get the ideas down. Later, if you can discuss the ideas with a 

colleague, the conversation is likely to strengthen your reflective thinking about the 

text and its interpretation. Then you can clarify and update your memo. Consider cod-

ing your memos alongside coding primary data to help sort your thoughts thematically 

and to keep them at the forefront when you read coded data later. For instance, we may 

have field notes from Barbara’s interview in a memo where we noted that she seemed 

uncomfortable discussing Balance, so we may code our notes related to this also to the 
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Balance code. We could also code our own writing to a code named Read more about this 

idea later, or Useful thoughts on method code, or a Things to do later code, all of which help 

to draw out different aspects of one’s own writing later. We will show you the basics of 

coding in Chapter 7.

Creating a Research Journal

	• Ribbon: Create > Memo (Figure 1.19).

Figure 1.19  Creating a memo to use as a journal

	• Name (provide a concise title).
	• 	Description (an optional, additional, brief overview of the memo).
	• 	Colour (use as an optional strategy for grouping items, such as memos about 

methodology).
	• OK / Done.

If you have a journal already started in a document outside of NVivo you can import it into the 
project:

	• 	Ribbon: Import > Files > Select the file > Open > Import.

INSTRUCTION 1.13
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Journal Writing, Saving, Closing, Reopening, and Editing

	• 	Open the memo > (tick box) Click to Edit / Edit.

	• Ribbon: Edit > Insert > Date/time (note the alternative shortcut keys: Ctrl / Cmd + 

Shift + T).

	• 	Ribbon: Home > Edit to adjust Format (colour), Style, etc.

	• 	Detail View: Write some ideas about your expectations for the project or  

a list of things to do next as you move forward with your design and  

analysis.

	• 	File / Menu bar: File > Save (although you do not need to save it before you close 

the Memo, only before you close the project).

	• 	Detail View: Select the X in your Memo tab (just above your date/time stamp) to 

close the memo.

	• To reopen the memo:

	{ Navigation View: Notes > Memos.
	{ 	List View: Double-click on the memo to re-open.
	{ 	Detail View: Click to edit with the blue bar just below the name of your memo / 

check box on the far right above your memo > add more thoughts.

INSTRUCTION 1.14

Exporting Your Memo

It can be useful to periodically export memos to share with team members. One useful 
practice is to export your research journal on a Friday afternoon and share it with oth-
ers in the team to update them on your progress. To export your memo, Right-click on 
a memo and export it into a text-based file (Figure 1.20).

You may end up with many memos, some linked and some not, some coded and 
some not. They can be easily searched and edited, making them a valuable resource 
that can document your research process, providing a detailed audit trail of decisions 
made, under what circumstances, and what you found out.

ACTIVITY

If you are importing only one memo, you will encounter the memo properties window where 
you can rename, add a colour, etc. (this can also be done later through the memo properties 
window) > OK / Done.

(Continued)
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Figure 1.20  Exporting your research journal memo

Mapping Your Initial Thoughts

We will show the various maps, graphs, and charts available in NVivo as they become 

relevant in each chapter. Sketching your ideas about your project at this stage is a par-

ticular form of journaling. These visualizations are a useful way to document what you 

are thinking – great for those who prefer to think and work visually, and beneficial even 

for those who sometimes struggle to work visually. Maxwell (2013) argues strongly for 

creating an early concept map to help clarify the conceptual framework or theoretical 

underpinning of a study.

Maps can be used throughout your project. In this chapter, we will use the mind map 

and the concept map as you begin shaping your research. This is a way of reflecting on 

the assumptions that you bring to the project as well as the concepts, relationships, or 

patterns you expect to find. This helps clarify your research questions and plan your 

data collection. If you have already collected data, the maps can help you start tracking 

the ideas that are already emerging.

If you find it a struggle to develop a map, then try some of Maxwell’s (2013: 62)  

suggestions:

	• Think about the keywords you use in talking about your topic, or in things 

you’ve already written about your research.

	• Take something you’ve already written (your research proposal, or a preliminary 

literature review perhaps) and map the implicit theory within it.

	• Ask someone to interview you about your topic, then listen to the tape and note 

the terms used.
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Create a Mind Map

A mind map is often used early in a project to map out initial ideas and how they may 

be connected. Use a mind map to explore a main idea or visualize a hierarchy or web of 

topics associated with that idea. While there are limitations to using mind maps – they 

are essentially a hierarchical visualization where everything either flows from the cen-

tral idea or is totally disconnected from it – many still find them useful in early stages 

of research. Add shapes to a mind map, name them, and add connections between them 

to represent concepts (Figure 1.21).

Creating a Mind Map

	• 	Ribbon: Explore > Maps > Mind Map > Provide a name for your mind map > 
OK / Done.

	• 	Detail View: Name your main idea for this project.

Connecting an Idea

	• 	Select the idea you created (main idea) and add a sibling or child idea to it.
	 OR
	• 	With the main idea selected > Right-click > Insert Child Idea > Name the idea.
	• 	Create a sibling idea: Right-click on an idea > Insert Sibling Idea > Name the 

idea.

Creating a Floating Idea

	• 	Detail View: In the white space Right-click > Insert Floating Idea > Label the idea. 
Floating ideas are used when there is not (yet) an obvious connection to the other 
ideas.

Creating Codes from a Mind Map

From your mind map you can create codes directly from the shapes. This is useful to 
convert initial ideas into codes to use in your exploration of the data.

	• 	Detail View: Click anywhere on white space to ensure the Detail View is active.
	• 	Ribbon: Mind Map > Create As Codes or Cases > Select location > Codes > 

OK.
	• 	Detail View: At the top > Create as Codes > Codes > Select.

INSTRUCTION 1.15

(Continued)
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Figure 1.21  Mind map on early thoughts in the Environmental Change Down  
East project

Reflecting on the Mind Map

At any time, create a memo about the mind map and write down thoughts about the 

organization of ideas in the map, and what the connections may mean. The mind map 

may continue to change over time. To keep the original, copy and paste it in the maps 

folder with a date of when it was created and update the copied version.

Chapter Takeaways

	• 	NVivo can align with any methodological choices and should not lead them.
	• 	Be aware that technology can both help and hinder our work, meaning that our 

qualitative work is sometimes influenced by NVivo or any other tools we use.
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	• 	Start using NVivo as soon as you begin your research. Think about your folder and 
file structure, your coding structure and the tools such as memos that are designed 
to help you think before you start coding.

Tips and Tricks

	• Save and create backups regularly. It is not a backup if it is on the same computer 
that created it.

	• Take time to think the data through and document key insights and everyday 
thoughts about the data in your research journal to not only show transparency of 
the research process, but also when, how, and why decisions were made.

	• Start using NVivo early in your research so you can learn the tools gradually and 
without as much pressure. Literature is a great place to begin.

	• Whenever you are not sure what to do or where to look for an action when you are 
working in NVivo, a context-sensitive menu can be accessed by right-clicking in the 
Navigation View, List View, and Detail View.

	• Mac users are encouraged to use one of the following options to enable a  
right-click:

	{ Purchase an external mouse with a right-click option.
	{ In your system preferences, configure your ‘secondary click’ to engage as 

a right-click with one of three options: Click or tap with two fingers, click on 
bottom right corner, or click on bottom left corner.

	{ Press Control/Command (ctrl/cmd) + click to access right-click options. This 
works for a 1-button mouse, MacBook trackpad, or with the built-in button on 
the standalone Apple trackpad.

Practice Questions

1	 How do you think the software might lead you? Articulate the circumstances in 
which this might be a good/bad thing.

2	 Think about the theoretical framework(s) that underpin your research. What kind 
of coding scheme might you start with?

3	 What kinds of memos (or topics within memos) are likely to help you with your 
research?

4	 What topics, themes, and patterns do you anticipate finding in your work? 
Create a memo and write about them, linking to available material (e.g. literature) 
when available.
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